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ABSTRACT 

 

Open educational resources, institutional collaborations, 

and content reusability approaches have been quickly 

emerging to minimize the time and money spent on 

developing e-learning materials.  Reusing content with 

reusable learning objects (RLOs) is carving a new path for 

research on reusing and repurposing available high quality 

e-learning content.  Prior research shows that this 

component-based approach best fits how educators prefer 

to access materials.  In this paper, without arguing the 

merits and demerits of RLOs as a concept, the authors 

present an effective and affordable approach to creating e-

learning materials with RLOs.  The authors also present 

how they have implemented the proposed RLO approach 

in converting learning modules of the Global Academy for 

Extension Practice into multiple e-learning material 

formats. 
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1. INTRODUCTION 

 

The top-down method1 of learning from teachers and other 

pedagogical standards is used not only in the formal 

education system; extension and training staff also use this 

method to train extension agents, farmers, 

nongovernmental organization (NGO) personnel, and 

students.  Even though this way of teaching and learning is 

part of our culture, changing scenarios and emerging 

opportunities allow extension and training institutes to 

explore innovative approaches [1].  Indeed, both efficiency 

and efficacy demand new approaches. 

 

Advances in information and communication technologies, 

specifically in multimedia, networking, and software 

engineering, have allowed an expansion of education 

beyond the traditional classroom to a geographically 

diverse audience.  Modes of delivery include television, 

radio, video, satellite, the Internet, and mobile phone [2].  

During the last several years thousands of electronic texts, 

images, movies, and Java applets have been developed to 

                                                           
1  In a top-down method of learning, teachers impart 

knowledge to those who they are teaching.  Teachers talk 

in front of the class, and the pupils have to listen and write 

down what the “knowing” teacher says. 

support these new innovative education and learning 

platforms [1].  

 

To take advantage of this situation, new services were 

developed and the search, classification, organization, and 

peer-to-peer exchange of learning resources by learners, 

instructors, and course developers became commonplace.  

Metadata 2  help to carry out these tasks, and several 

specifications for learning objects were produced.  Related 

to this, specialized search engines and indexing tools for 

learning were also made available [3].  

 

The increasing use of the Internet [4] and its technological 

capabilities, in addition to the huge amount of learning 

resources, allowed for the evolution of a high number of 

technology-based learning platforms such as open 

educational repositories Open Courseware Consortium 

[5], MIT Open Courseware [6], MEROLT [7], GEM [8], 

and Wikipedia [9]; content management systems Plone 

[10], Drupal [11], and Joomla [12]; and learning 

management systems Blackboard [13], ATutor [14], TeN 

Acado [15] and Moodle [16].  As they are usually 

developed ad hoc, to meet the requirements of a particular 

institution, heterogeneous systems appear with no 

interoperability mechanism among them.  

 

When these systems were reviewed, our conclusion was 

that they provide very similar functionalities: content 

delivery, learner tracking, learner management and 

administration, questionnaire evaluation, communication 

and collaboration facilities, search tools, etc.  Therefore, 

we can state that most online learning systems share some 

common functionality, usually implemented from scratch 

for each one of them.  In this sense, software reuse would 

be a must to reduce the time-to-market factor.  

 

The “observable problem” is that there is a lack of 

interoperability mechanisms among heterogeneous 

platforms.  Such mechanisms would allow for a particular 

online learning system to provide its own content delivery 

module, which uses a common learner administration 

system provided by an external institution and, maybe, 

developed by a different vendor.  

 

The identification of a common architecture, composed of 

basic software components that provide open interfaces, 

would contribute to both reuse and interoperability.  

                                                           
2 Meta-data is data about data, which provide a common 

way for learning resources to be described.  Learning 

resources that have been described by meta-data can be 

searched for and retrieved for use and reuse.  
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Keeping this in mind, an experiment was carried out from 

July to December 2010 at Iowa State University’s Global 

Extension program.  The work focused on developing a 

method to create a reusable, interoperable, accessible and 

durable reusable learning objects (RLOs) repository for 

rapidly producing e-learning materials to support Global 

Academy for the Extension Practice activities.3   

 

 

2. OBJECTIVES 

 

A. Content (learning material) generation.  

B. Creation of Reusable Learning Objects (RLOs).  

C. Rapid customization of Reusable Learning 

Objects to produce e-learning materials. 

D. Delivery of E-learning materials  

 

A. Content Generation 

E-learning content includes elements such as lessons, 

quizzes, tests—essentially anything that a lecturer or 

teacher/instructor/trainer would want to make available to 

the learners on the Internet. In our Global Academy for 

Extension Practice project, the e-learning content related 

mainly to extension material and primarily took the form 

of either static (or) dynamic content.  

 

The learning content in the form of HTML pages and 

Flash documents, along with any images or audio or video 

files embedded in these pages, generally is known is static 

e-learning content.  This type of learning content (static in 

nature) does not change for the learner.  Also, nothing is 

stored about the learner in a database or as a file for the 

extension agent, trainer, or instructor to refer to.  

 

The learning content related to quizzes or tests require 

results to be stored in a database so that the extension 

agent, trainer, or instructor can refer to the results for each 

learner.  This requires a dynamic system to record the 

personal information of the learners and their results.  

Using several programming languages such as JSP, CGI, 

PHP, ASP, etc. to develop this kind of learning content is 

widely practiced.   

 

The content designers and developers of electronic 

learning content generate both static and dynamic learning 

content to support e-learning environments for learners of 

different domains around the globe.  This way of content 

creation is common in e-learning environments and best 

suits the requirements of a particular institution.  This kind 

of e-learning content is context- and technology-specific, 

and often modifications to the existing e-learning content 

or adoption of this learning content for other purposes 

requires reworking of the content.  For example, the 

content in the Flash exe format does not allow for making 

any changes and the HTML format requires delinking all 

                                                           
3

Global Academy for Extension Practice is a strategic 

coalition of regional, national and international partners 

for extension practice.  The program is designed to bring 

widespread systematic change in the existing extension 

functionaries by (a) inculcating core competencies in the 

extension professionals; (b) enhancing institutional level 

capacities with pluralistic approaches; and (c) creating a 

cadre of new extension professionals, with rural women 

and youth, to promote the rural innovation necessary to 

achieve sustainable food security, reduce poverty, 

conserve natural resources, and address other rural 

problems. More details may be found at 

http://wikieducator.org/images/5/5e/Mary_Holz-

Clause.pdf [1]. 

the existing pages and linking them again with added 

pages in a newly defined order.  This has been viewed as 

an expensive and time-consuming process.  Therefore, the 

development of content enabled to be packaged as RLOs 

is carving a new path for research on reusing and 

repurposing content across multiple e-learning platforms.   

 

B. Creation of Reusable Learning Objects 

RLOs are a specific chunk of digitized instructional 

content that can be reused in many different courses.  

According to Dahl and Nygaard [17], learning objects are 

elements of a new type of computer-based instruction 

grounded in the object-oriented paradigm of computer 

science.  Object orientation highly values the creation of 

components (called “objects”) that can be reused in 

multiple contexts.  Reigeluth and Nelson [18] suggested 

that when teachers first gain access to instructional 

materials, they often break down the materials into their 

constituent parts.  They then reassemble the parts in ways 

that support their individual instructional goals. This is the 

fundamental idea behind RLOs: e-learning content 

designers and developers can build instructional 

components that can be reused a number of times in 

different learning contexts.  These RLOs can be tailored 

according to specific needs and delivered over the Internet, 

meaning that any number of people can access and use 

them simultaneously.  Moreover, those who incorporate 

learning objects can collaborate on and immediately 

benefit from new versions.  

 

To facilitate the widespread adoption of the RLOs 

approach, the Learning Technology Standards Committee 

(LTSC) of the Institute of Electrical and Electronics 

Engineers (IEEE) formed in 1996 to develop and promote 

e-learning technology standards [19].  Without such 

standards, universities, corporations, and other 

organizations around the world would have no way of 

assuring the interoperability of their e-learning platforms 

and technologies, specifically their RLOs.  Though many 

standards, such as ARIADNE [20] , IMS [21], AICC [22], 

SCORM [23] etc., are available we have adopted SCORM 

specifications for our work to make RLOs technically 

independent. 

 

SCORM Specifications: Sharable Content 

Object Reference Model (SCORM) is a suite of technical 

standards and speciation given by ADL, 4  that enables 

electronic learning systems to find, import, share, reuse, 

and export learning content in a standardized way.  The 

purpose of SCORM is to achieve interoperability, 

reusability, accessibility, and durability [23].  

 

Building of a SCORM Compliant RLOs 

Repository:  The repository, in this context, refers to the 

server/computer where RLOs are organized and stored.  

Newly created RLOs are continuously added to this 

repository in an organized way. 

 

Creation of RLOs:  An RLO can be created 

with the help of objects available in the repository or by 

new user-defined objects. The design and development of 

RLOs follow pedagogy and SCORM specifications.  

SCORM specifications include both the content 

aggregation model (CAM) and the run time environment 

(RTE).  CAM deals with the process of creating, 

discovering, and gathering together simple assets into 

complex sharable learning objects and the organization of 

                                                           
4
 ADL: Advanced distributed learning 

http://www.adlnet.gov/index.cfm 
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those learning objects into a predefined sequence for 

delivery.  RTE deals with the delivery of RLOs.  

 

For instance, Aphid (see Figure 1) is an RLO created with 

simple assets (two images and text).  This instruction 

describes with images the description, damage symptoms, 

and management of aphids. 

 

An RLO can be developed in any format (i.e., html, flash, 

.doc, .ppt, jpeg, gif etc.).  The content authors are 

interested in content rather than on technology.  This 

particular approach enables the content authors to use the 

content available in any technical format.  

 

 

 
C. Rapid Customization of Reusable Learning Objects 

(RLOs) to Produce e-learning Materials 

This section describes the step-by step-procedure to 

customize RLOs for creating an electronic learning 

content.  

 

Course Organization: Content authors have to 

identify the subject of interest and develop the relationship 

between/among the RLOs.  Accordingly, authors and 

designers should organize the sections and subsections of 

the course.   

 

Linking RLOs:  Tailor or link the RLOs using 

any user-friendly editor: GUI, ADL SCORM Editor, 

RELOAD Editor.  Customization of RLOs using 

RELOAD editor is explained in Figure 2.  

 

 
 

Figure 2. Process of customization of RLOs for creating an 

electronic course 

Customization of RLOs: After selecting the New > ADL 

SCORM 1.2 Package from the File menu, open the desired 

section of repository in the reload editor left resource pan.  

Add an organization for the new course by right clicking 

on the organization available at the right manifest pan (top 

frame), and change the organization name according to the 

course title by renaming it at the right attribute pan 

(bottom frame).  Now drag and drop the RLOs from the 

left resource pan to the right manifest pan.  Change the 

section and subsection names according to the new course.  

To preview the new course, click on Preview Content 

Package from the View menu.  Click on the Zip Content 

Package from the File menu if the new course is ready in 

its desired form (Figure 2). 

 

D. Delivery of E-learning materials 
Deliver the packages to learners by uploading them into 

learning content management systems (LCMS) or content 

management system (CMS), or develop an application 

program interface to provide a run time environment to 

support various e-learning platforms ranging from Internet 

Radio to mobile phone. 

 

 

3. PRILIMINARY RESULTS 

 

The compatibility of content packages was tested on 

ATutor, TeN Acado and Moodle.  The SCORM 

compliance RLO content packages were downloaded from 

ATutor (open source learning content management 

system) [14] and played in TeN Acado (commercial 

courseware management system) [15] and Moodle (open 

source course management system) [16] as a new learning 

content module with newly defined modifications.  

 

For instance, the chickpea learning content package 

(consisting of production practices, insect pests, and 

diseases) was downloaded from ATutor and uploaded to 

TeN Acado to create a chickpea insect pest course.  In 

Acado the production practices and diseases sections were 

deleted and the insect pest sections were edited to create a 

new course, “Chickpea Insect Pests.”  This approach 

shows that the SCORM compliance content packages 

could be playable in any standard open source and 

commercial CMS, LMS, or LCMS.  The entire process 

took only a few minutes time and produced new learning 

material from existing learning material.  This approach 

shows a way to produce e-learning materials rapidly from 

existing learning materials from an RLO repository.   

 

We have started implementing this approach in our 

project, the Global Academy for Extension Practice, to 

minimize the time and money spent on producing need-

based e-learning materials for our regional hubs located in 

developing countries.   

 

The Global Academy for Extension Practice learning 

materials are available at http://courses.extension.iastate 

.edu/course/category.php?id=18 (Figure 3) for 

noncommercial usage, testing, and feedback.  

 

 

Figure 1. Aphid RLO 
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Figure 3. Global Academy for Extension Practice  

E-learning platform 

 

 

4. CONCLUSION 

 

The most crucial problem that exists today in electronic 

learning is creating need-based location-specific electronic 

learning content in an affordable way and delivering it 

across heterogeneous platforms.  This has been even more 

challenging in mass agricultural extension and education 

as the learning content varies with various cultures, 

climates. and geographic regions.  

 

In this paper, the presented RLO approach addressed a 

central aspect of this issue effectively, i.e., rapid 

production of desired e- learning content from the RLOs 

(reusable, interoperable, durable, and accessible) resource 

pool with required changes and modifications.  We have 

demonstrated through experimentation with existing 

learning content packages throughout various learning 

management systems how the new learning materials can 

be generated and played among and across multiple e-

learning platforms with the RLOs approach and SCORM 

specifications.  
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i
End note 

                                                           
i
 The paper was written when both the authors were 

associated with the Iowa State University Extension, 

USA.  
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